Diamond Engraving Tool

EgoBot)  INSTALLATION AND
USAGE GUIDE

(Covers kit & assembled versions of Diamond Engraving Tool)

The Diamond Engraving Tool is an optional accessory for The Original Egg-Bot Kit, http://egg-bot.com/

The Diamond Engraving Tool turns your EqgBot into a vibrated-tip diamond-point engraving tool, capable

of light-duty marking and drawing on hard materials like glass, stone, and ceramic.

This installation and usage guide covers the procedures for attaching the engraver tool to your EggBot, and

getting started with it.

You can find the latest version of this manual at: http://wiki.evilmadscientist.com/Engraver

Support Forum: http://forum.evilmadscientist.com/

Distributed by W Evil Mad

Evil Mad Science LLC
http://shop.evilmadscientist.com/

. . Usage Manual v. 2.0
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EggBot ) Diamond Engraving Tool

PLEASE READ THESE IMPORTANT
SAFETY NOTICES ABOUT YOUR KIT

Caution: Please exercise appropriate care when installing and using your engraver kit: The
kit contains small parts and sharp parts (like the diamond). Keep out of reach of small
children. Older children and teens may require adult assistance.

Caution: Dust created by engraving objects can be potentially hazardous. Assure good
ventilation and take additional necessary precautions if you are engraving objects that
can create hazardous dust.

Warning: The engraver is capable of cracking and shattering fragile objects like lightbulbs
and christmas ornaments, which could potentially result in sharp, flying shards. Wear
safety glasses, and do not allow children to operate the engraver without adult
supervision.
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Step 1A: Identify parts (all models except EqgBot Pro):

Upper pen arm assembly, with
vibrating motor and driver
board

Diamond point tool, in
mount

On pre-assembled models:
Note that the circuit board may be
mounted above the wooden parts.

Washers:
Nylon (2)
Rubber (1)

“Servo” cable
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Step 1B: Identify parts (Engraver for EqgBot Pro):

Diamond point tool,

) in mount, preinstalled
Mounted controller board with P

“servo” cable pre-attached.

Distal pen arm assembly,
with vibrating motor
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Delrin hinge
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Step 2A: The diamond tool and its mount

Diamond Mount

\

3/8-16 Thumbscrew

Diamond point tool S

3/8-16 hex nut

Protective rubber
boot

\ 1/8” steel shank

90° honed diamond point
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Step 2B: The diamond tool and its mount (continued)

The diamond point tool is held in its mount by
friction. If you need to remove and replace it, use
pliers to pull the tool out, with a twisting motion.

To replace the tool, first set it loosely in the mount.
Then, set it diamond-face down on top of a piece of
hardwood (or a stack of scrap paper), and press
down hard on the thumbscrew.

T Be careful!
Tip is sharp, can cut skin (and glass...)

Use the protective rubber boot to cover
the tip when not in use.

e —
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STEP 3: Attaching the Diamond Mount
>>> EggBot Pro users: Skip this! Go to Step 8. <<<
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The diamond point tool can be
installed on or removed from
the pen arm whenever you like.

|

Place the diamond mount through the “pen” hole.

Begin with the hex nut removed from the Diamond Mount.

To tighten the Diamond Mount in place, hold the hex nut
steady with your fingers, and and turn the thumbscrew until
the mount is firmly tight.

Thread the thumbscrew into the
hex nut

alls

AR

: i Do not overtighten, and especially,
&® 3 do not use wrenches or sockets to
" tighten the hex nut.

[7]
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STEP 4: The Engraver’s Servo Cable

Connect the cable to the three pins. The black wire
goes to “—", the red to “+” and the white to “sig.”

R s

i
i
i

. s

The three-conductor “servo” cable that powers the
engraver hooks up to the driver board through this
connector. The pins are labeled “-",“+”, and “sig” (for
signal). In practice, the labels may be hard to see.

[ — ———

Even if you can’t see the tiny markings on the
circuit board, you should be able to verify that
the servo cable orientation is as shown here.

————
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STEP 5A: The upper pen arm assembly

The Diamond Engraving Tool replaces this part of your

/ Eggbot, the “Upper pen arm assembly.”
\ Only one screw is needed to swap out the upper pen

arm assembly, so you can easily switch back and forth
between your regular assembly (which has a softer
hinge) and the engraver’s assembly.
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STEP 5B: Remove your upper pen arm assembly @

This screw holds the upper
pen arm assembly in place.

Set aside your original upper pen arm assembly
for when you want to switch back to using pens.

...... ¥ " ' \ You just unscrewed this 6-32 x 3/8” screw.
’ - : Keep it handy; we'll need it in the next step. [10]



STEP 6: Install the new upper pen arm assembly

l Put one of the nylon washers I l Attach the new upper pen l

over the 6-32 x 3/8” screw. arm, where the old one was. 4

W W -
/v

l The new assembly should tighten in place securel l

y.
If it does not tighten securely, put a second nylon Theduppel.* an arm does not
washer over the screw and try again. need to sit flat; it may estiat

a slight angle.
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STEP 7A: Route the cable

o The servo cable goes up and
over the pen arm...

...And finally, to location B3 on the EBB, the top servo connector.
The black conductor goes towards the outside of the EBB. [12]



STEP 7B: Test the reach of your cabling

Final hardware installation step:

Make sure that your pen arm can reach all the
way to both ends of its travel, without being
constrained by the cables.

>> Skip ahead directly to Step 10.
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STEP 8: Attach the Engraver ~ (EggBot Pro) !

Remove the two indicated hex
screws, along with the two-hole
steel hinge washer piece.

Tighten the two screws in
place.

Place the two hex screws
through the hinge washer,
and onto the flexure hinge.
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STEP 9: Cable Routing
& Test (EggBot Pro)

The mounted controller board
for the EggBot Pro engraver sits
behind the chassis, rather than
riding on the pen arm.

Plug the loose end of the servo cable into the TOP three pins
¢ on the lower left of the EBB driver board: the set labeled “B3.”
The black wire goes towards the back edge (pen motor side).

i Final hardware step: ,
¢ Make sure that your pen arm
' can reach all the way to both
¥ ends of its travel, without being
. constrained by the wires.

(Close up view.)



STEP 10: Prerequisites

The Diamond Engraving Tool is an Eggbot ‘
add-on, and the rest of these instructions
assume that you are already be familiar with
basic usage of the Eggbot (with pens!).

T ————— ——
}_'1 EViI Mad o S : i — Go  Search
So, if you are just getting started with Eggbot, /I\ Scientist 79° UeoeEen Read | o Sy
please begin with the main documentation, o~ - ) .
and make sure that you are comfortable W|k| The Orlglnal Egg-Bot Kit
making basic plots before proceeding here. This page is the central documentation site for The Original Egg-Bot kit from Evil Mad Scientist 2.

Project Documentation
Eggbot documentation lives at:

L o The Egg-Bot Kit Contents [hice]
http://wiki.evilmadscientist.com/Eggbot The Bulbdial Clock Kit { The Original Egg-Bot Kit
Octolively 2 Ostrich Egg-Bot Kit
R — E——— Interactive Game of Life 3 Tutorials
Alpha Clock Five 4 Advanced topics and tips
Peggy 2 and 2LE 5 Support Resources
WaterColorBot
Moggy & Ficl The Original Egg-Bot Kit [edit]
Diavelino
Relay Shield Main details about the Egg-Bot kit:
Art Controller « Announcement article ¢ at Evil Mad Scientist Laboratories
Discrelelsss Timeriit ¢ Product page & at Evil Mad Scientist shop
i Dlscretef el * egg-bot.com, the official site, featuring the Eggbot FAQ &
Googly Eye Shield
ISP Shield
e oo Getting started with Eggbot: Essential documentation
LED Menorah « Part |: Assembly guide. Two versions are available:
Snap-O-Lantern (A) Single-file PDF version: Available here [, a 27 MB PDF document (Trouble Viewing? Please click here.)
(B) Page-by-page online version: Available here i,

Navigation e Part Il: Installing software
Main page ¢ Part |ll: Making your first plot

Recent changes
Evil Mad Science shop . . g
Evil Mad Scientist blog OSt"Ch Egg'BOt Kit fedi]

Wiki help
« The Ostrich Eggbot Kit - an extra large chassis for plotting on larger objects
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STEP 11: Verify that your software is up to date.

From the Inkscape Extensions menu, open Eggbot Control, and
select the “*” tab that shows the version number of your software.

[f Previous Extension

g 1| fE K

Previous Extension Settings...

&
Arrange >
Color >

EggBot Contributed > Preset hatch for fills...
Export >

Geodetools > Strip Eggbot Data
Geodetools...
Generate from Path
Images

|essyink

——  Modify Path

Reorder Paths for Speed...

Raster
Render

Text

Visualize Path
Web

WOW WOV W WY WV VYWY
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The engraver kit requires Release 2.2.1 or newer.

If you have an older version of this software, please visit
http://wiki.evilmadscientist.com/Engraver and follow the link
“Update Eggbot Software” for instructions.

m

e NN '\ Eggbot Control

Plot Setup Timing Options Manual Resume Layersm

, t Cormerelinkscape extension
R Release o h el ed 6/12j2011

*EBB F|rmware 1.96 or newer required for certain
2 functions. Version 2.0.2 or newer recommended.

Known issues:
* "Cancel" function does not work while plotting.
(This is due to a known bug in Inkscape.)




STEP 12: Enabling (or disabling) the Engraver

Under the “Options” tab of Eggbot Control, there
is an option called “Enable engraver, if attached.”

If this box is checked, then the engraving motor
will turn on when you begin a plot, and turn off
automatically when the plot finishes.

Uncheck this box if you want to leave the
Engraver’s upper pen arm assembly in place, but
do not want to turn the motor on.

Other than selecting this option, there are no
other essential steps to operating the Diamond
Engraving Tool.

—

T —

Note that you can also disable the engraver by
disconnecting its servo cable at one or both ends.

-
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5.0 \, Eggbot Control

Plot Setup Timing| Options Manual Resume Layers *

0 Reverse motion of Motor 1 (pen):

4 Reverse motion of Motor 2 (egqg):
W) Egg (x) axis wraps around:
74 Start with pen centered:
|| M Return home when done:
— v Enable engraver, if attached

Curve smoothing (lower for more): 0.2

| A
v

MNote: Pressing 'Apply' will apply settings, but not plot.

K close l

apply |
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STEP 13: Manual control of the Engraving tool

Under the “Manual” tab of Eggbot Control, there are options called “Engraver On” and “Engraver Off.” ,

T —————

If “Engraver On” is selected, then the engraving motor will
turn on immediately when you click the “Apply” button,
but only if the engraver is also enabled in the Options tab.

S —

s NN N\ Eggbot Control

e

Plot Setup Timing Options Manual Resume Layers *

Eggbot Manual Control

You can use this frame to send "manual" commands
to the Eggbot: Walk the stepper motors, raise or
lower the pen, enable or disable the motors, or
check the circuit board (EBE) firmware version.

Command: léEngraver on v

| |

A 1
Wwalk distance (steps): 1600

Mote: Walk distance can be positive or negative.

Press 'Apply' to execute the command.

¥ Close Apply
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If “Engraver Off” is selected, then the engraving motor will
turn off immediately when you click the “Apply” button,

whether or not the engraver is enabled in the Options tab.

% Eggbot Control

Plot Setup Timing Options Manual |Resume Layers *

Eggbot Manual Control

You can use this frame to send "manual" commands
to the Eggbot: Walk the stepper motors, raise or
lower the pen, enable or disable the motors, or
check the circuit board (EBB) firmware version.

W ‘Engraveroff Ty
walk distance (steps): 1600 |2

Note: Walk distance can be positive or negative.

Press 'Apply' to execute the command.

€ Close | |
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STEP 14: Factors influencing quality of engraving

Many factors influence the quality of engraving
possible with the Diamond Engraving Tool for Eggbot.

Chief amongst these are
* The type of surface being engraved
* The speed of engraving (“pen down” speed)
* The pressure applied by the engraving tool
* The strength of vibration applied by
the engraving motor

Generally speaking, you can get the finest quality
engraving by using a slow pen-down speed (often in
the range 25-100), in combination with moderate
pressure and moderate vibration strength.

Depending on your needs, you may prefer to increase
the speed of engraving (perhaps as high as 300), while
increasing the pressure and vibration strength.

When working with fragile items like glass ornaments,
you may also want to drastically reduce the “Pen
lowering speed” — so as to only gently lower the
diamond point onto the surface.

(Hammering the diamond point down is a good
technique for engraving certain hard surfaces, but is

also a very good way to break fragile objects.)
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%\ Eggbot Control

Plot Setup T|m|ng Options Manual Resume Layers *

—

P Speed when pen is down (steps/s):

Speed when pen is up (step/s):

Pen raising speed (%/s):

Delay after raising pen (ms):

Pen lowering speed (%/s):

Delay after lowering pen (ms):

-~

25 =

~
W

400

el

50

e

300

3

v
~
e

-~

500

v

MNote: Pressing 'Apply' will apply settings, but not plot.

H close

| < apply |
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The strength of vibration of the engraver
motor is controlled by this “trimpot” on
the driver board, which controls the
engraver-motor current.

Use a miniature Phillips-head screwdriver
to adjust the current. The total range of
adjustment is less than one turn; do not
force it.

Turn it counterclockwise to increase the
current, cloclkwise to decrease the current.

The LED will light up proportionally for
moderate and high current. For very low
currents, it may not light at all.
R ——

——
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STEP 16: Example: Engraving a stone sphere

W
Here we are engraving into the surface
of a white marble (stone) sphere.

When engraving rigid objects, you can apply substantial
pressure. Here, the “pen” is down, with the diamond
against the surface. The angle of the pen arm allows
the hinge to apply downwards pressure.

Center the diamond point (not the pen
arm, but the point itself) directly above the
center of your object before plotting. '

mond Engraving Tool for. Eqgbot::Usage guide]



STEP 17A: Example: Etching glass christmas ornaments (part |, preparation)

r w w .

N

Glass christmas ornaments are good items to
etch or engrave with the Eggbot.
(You can also decorate them with pens!)

First, though, you need to
remove the little hanger clip.

w

Replace cap
Slide out the clip /

Squeeze together gently

P

Remove the clip Replace the cap, providing a flat mounting
surface. The clip can be replaced when
you are done.
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STEP 17B: Example: Etching glass ornaments (part II) ,,
N ‘

: ~ NEr

i tailstock pressure §
i . with fragile objects. §

f,_ & —H —

L/ : For smooth glass surfaces, the Precision Egg Coupler

v;_ & " does not provide the correct kind of friction for good
Mount glass ornaments with the cap facing the tailstock. = coupling. Place the rubber washer between the coupler
You may need to rotate your artwork 180° to match. " B and the glass ball for extremely reliable motion.

Apply minimal plottin vfessuré, 3
Glass ornaments usually PPYY plotting p
; assume that breaks will happen from
have very thin walls.

- im ime, and take approbriate
Glass can break. /7 ~ time to time, and take app P.
safety precautions.
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